
Doors.NET™ Situation Manager – Global Lock/Unlock
Application Note
The Situation Manager is an advanced Doors.NET feature implementing Global Lock/Unlock 
commands. This allows an operator to immediately lock or unlock a designated group of doors, over 
multiple controllers, using either designated hardware inputs or a unique set of icons on the software 
ribbon bar.

NOTE: PXL controllers must be at firmware v8.6.09 or greater to properly use all aspects of the 
Global Lock/Unlock feature.

1.0 Description
The Doors.NET Situation Manager extends the basic Global Lock/Unlock feature implemented in 
Doors with PXL hardware. The Doors.NET implementation provides a Situation Manager that takes 
advantage of the power and flexibility of Doors.NET software and its supported controllers and 
hardware to provide greater control on how Global Lock/Unlock is implemented. The following list 
describes how the Situation Manager implements Global Lock/Unlock.

• When enabled, Doors.NET adds a Situation Manager sub-group of icons to the program ribbon 
bar. These icons display current state and allow an operator to activate Global Lock, Global 
Unlock, or return to normal operating state.

• When a Global Lock command is initiated, designated doors immediately return to their normal, 
valid credential required state. All Auto-Unlock/ Lock Timezones are overridden, but all valid 
credentials will be granted access.

• When a Global Unlock command is initiated, designated doors are immediately unlocked.
• Any input on an NXT controller, 4x4 expansion module, or SB-593 expansion board (PXL) that is 

not configured for door operations (i.e., door contact, alarm, or REX) can be designated as a 
Global Unlock or Global Lock input. Multiple inputs across multiple devices can also be 
designated.

• Global Unlock and Global Lock commands can operate over multiple controllers and over 
multiple Gateways, even if they are different Gateway types (for example, a cohabiting system 
that uses both standard NXT and NXT Mercury Powered controllers).

• Either the System Calendar or the optional Global Linkage feature can activate Global Lock and 
Global Unlock commands.

Operator Configurable Options

• Select which doors participate in Global Lock and/or Global Unlock.
• Set the override precedence between Global Lock and Global Unlock. This allows the operator to 

determine if a Global Lock command overrides a Global Unlock command or vice-versa.
• Configure if manual operation from the user interface is allowed to override either Global Lock or 

Global Unlock or both. If allowed, the operator can manually lock or unlock any door using the 
user interface or via global linkage. If not allowed, the manual operation command is ignored and 
a message is logged.

• Set precedence between the Situation Manager icons versus hardware inputs; the preferred input 
method takes precedence if multiple Global Lock and Global Unlock commands are activated 
during the same incident.
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• Set input preference – Latched or Momentary
- Latched input configures the Global Lock or Global Unlock command to follow the state 

of the input: ON activates the command, OFF deactivates the command.
- Momentary configures the input to trigger the Global Lock or Global Unlock command to 

activate. The command must be reset via the Situation Manager in the software.

• Global Lock supports three levels of “Lock:”
- Lock – immediately locks designated unlocked doors (doors on a schedule or are 

manually unlocked). Locked means that credentials that have valid access still work 
and the REX still works.

- Lock-Out – operates the same as Lock but no credentials are allowed access 
regardless of access level/group permissions. REX functions normally.

- Lock-Down – operates the same as Lock-Out with REX no longer functioning.

2.0 Situation Manager Configuration
Situation Manager configuration allows you to define how Global Lock/Unlock is applied to the 
system. You must be logged in at a system administrator level to configure Situation Manager 
options.

NOTE: Situation Manager configuration options become read-only if the system is in an active 
Global Lock or Global Unlock state. This prevents a configuration change from being made that may 
affect or confuse the current Global Lock/Unlock state. This read-only state does not apply to other 
properties or configuration options for other features within the program.

2.1 Enable Advanced View
The Situation Manager and the Global Lock/Unlock data fields are a part of Doors.NET’s Advanced 
View feature set, so you must enable Advanced View to access and configure this feature.

1. Click the View tab > Advanced View ribbon icon.
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2. A Password window appears.

3. Enter “Keri10” – the default password.
4. Click OK. The Advanced View feature set is now enabled.

2.2 Enable Situation Manager
1. Click the Setup tab > System Options ribbon icon to open the System Options window.

2. Click Situation Manager in the list of System Options.
3. In the grid, click in the Enabled field and select Yes in the pull-down menu.
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4. The Situation Manager options are now ready to be configured.

2.3 General Configuration Options
The General Configuration grid allows you to set Situation Manager activation options. Refer to the 
following figure for all General Configuration options.

2.3.1 System Administrator Only
Limits access to the Situation Manager to operators who have System Administrator level logins. The 
default is to not require a System Administrator login to activate the Situation Manager.

1. To require a System Administrator login, click in the System Administrator Only field in the grid 
and select Yes from the pull-down menu.

2.3.2 Enable Global Macro
This setting can be used only if the optional Global Linkage Service is installed and enabled on your 
license key. The setting allows a Global Linkage Macro to change the Situation Manager Global 
Unlock/Lock states.

2.3.3 Enable System Calendar
If the System Calendar is enabled on your license, this setting allows you to use the System Calendar 
to change the Situation Manager Global Unlock/Lock states. This option will only display if System 
Calendar is enabled on your license.

2.3.4 Require Notes and Set Notes Length
Allows you to require a note of explanation when an operator activates a Global Lock or Unlock via 
the Situation Manager. You can then set the minimum number of characters the note must have. The 
default is to not require a note.

1. To require a note of explanation on activation of a Global Lock or Unlock, click in the Require 
Notes field in the grid and select Yes from the pull-down menu.

2. Then click in the Notes Length field and set the minimum number of characters for the note. You 
can either directly enter the number of characters or use the displayed slider to set the length. The 
maximum is 128 characters.
Page 4 of 19 P/N: 01623-001 Rev. A



Doors.NET™ Situation Manager – Global Lock/Unlock
Application Note
2.3.5 Require and Set Password
Allows you to require a password to activate the Situation Manager and set the password to be 
entered. The default is to not require a password.

1. To require a password, click in the Require Password field in the grid and select Yes from the pull-
down menu.

2. Then click in the Password field and enter the desired password. Your characters are displayed as 
you type so you can verify your entry prior to saving.

2.4 Global Configuration Options
The Global Configuration grid allows you to configure how the Global Lock/Unlock rules are 
applied. Refer to the following figure for all Global Configuration options.

2.4.1 Global Unlock Enabled
Enables Global Unlock, placing the Global Unlock icon and the Normal icon into the Situation 
Manager field of the ribbon bar. The default is not enabled.

1. To enable Global Unlock, click in the Global Unlock Enabled field in the grid and select Yes in 
the pull-down menu.

2.4.2 Global Unlock Ignore Override
When enabled, this option prevents an operator from issuing a manual door command such as lock 
door, unlock door, temporary unlock, control point override, or monitor point override that would 
countermand the Global Unlock command. If an operator attempts such a command a message 
appears stating the command could not be completed and a corresponding event message is recorded. 
The default is not to ignore overrides, allowing an operator to manually operate doors in a Global 
Unlock state.

1. To ignore manual commands that override a Global Unlock, click in the Global Unlock Ignore 
Override field in the grid and select Yes in the pull-down menu.

NOTE: This setting is system wide. If enabled, no manual overrides are allowed regardless of 
hardware settings.
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2.4.3 Global Lock Enabled
Enables Global Lock, placing the Global Lock icon and the Normal icon into the Situation Manager 
field of the ribbon bar. The default is not enabled.

1. To enable Global Lock, click in the Global Lock Enabled field in the grid and select Yes in the 
pull-down menu.

2.4.4 Global Lock Ignore Override
When enabled, this option prevents an operator from issuing a manual door command such as lock 
door, unlock door, temporary unlock, control point override, or monitor point override that would 
override the Global Lock command. If an operator attempts such a command a message appears 
stating the command could not be completed and a corresponding event message is recorded. The 
default is not to ignore overrides allowing an operator to manually operate doors in a Global Lock 
state.

1. To ignore manual commands that override a Global Lock, click in the Global Lock Ignore 
Override field in the grid and select Yes in the pull-down menu.

NOTE: This setting is system wide. If enabled, no manual overrides are allowed regardless of 
hardware settings.

2.4.5 Global Lock Type
Specifies what action to take when a Global Lock command is issued. The three different actions are:

• Lock – immediately locks designated unlocked doors (doors on a schedule or are 
manually unlocked). Locked means credentials which have valid access still work 
and the REX will also be enabled.

• Lock-Out – operates the same as Lock but no credentials are allowed access 
regardless of access level/group permissions. REX functions normally.

• Lock-Down – operates the same as Lock-Out with REX no longer functioning.

The default is Lock.

1. To set a different Global Lock type, click in the Global Lock Type field in the grid and select the 
desired Lock, Lock-Out, or Lock-Down option in the pull-down menu.

2.4.6 Precedence
Determines which mode can override the other. The default is Global Unlock has precedence over 
Global Lock.

• If Global Unlock has precedence then Global Lock will not take effect until the Global Unlock is 
cleared.

• If Global Lock has precedence then Global Unlock will not take effect until the Global Lock is 
cleared.
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1. To set the mode override Precedence, click in the Precedence field in the grid and select the 
desired Global Unlock Has Precedence or the Global Lock Has Precedence option in the pull-
down menu.

NOTE: Precedence only applies if hardware inputs are being used to initiate Global Lock or Global 
Unlock actions. If hardware inputs are not being used, the Situation Manager icons on the ribbon bar 
directly handle switching between Global Lock, Global Unlock, and Normal states.

2.4.7 Hardware Control
Specifies whether the software is in control (via the Situation Manager icons) or hardware inputs are 
controlling the changes to the Global Lock/Unlock and Normal states. The default is hardware has 
precedence.

• If Software has Precedence, then the Situation Manager icons on the ribbon bar display status and 
directly control switching between Global Lock, Global Unlock, and Normal states. A physical 
input is not required in this mode but not excluded either; you can use both.

• If Hardware has Precedence, then the Situation Manager icons on the ribbon bar display status 
only and nothing happens when an operator clicks on the icons.

1. To set the Hardware Control precedence, click in the Hardware Control field in the grid and select 
the desired Hardware Has Precedence or the Software Has Precedence option in the pull-down 
menu.

2.4.8 Global Reset Type
Specifies how the system will reset a hardware initiated Global Lock/Unlock and return to the 
Normal state. There are two types of hardware states: Latched or Momentary.

• Latched means the state of the Lock/Unlock command follows the state of the input – ON = 
enabled, OFF = disabled (typically a single throw-switch)

• Momentary means the Lock/Unlock command is enabled when the input is tripped (typically a 
push-button, momentary switch)

The default is Latched.

• If Latched, then internal logic is used to determine when to return the mode back to Normal.
- If multiple hardware inputs are used for Global Lock and/or Global Unlock, the system will 

reset to Normal only after every input has returned to normal.
- In the case where there are multiple inputs for Global Lock and Global Unlock with at least 

one input for each has been triggered, internal logic is used to take the system to the correct 
state based on the Global Lock/Unlock Precedence property.

• If Momentary, then no logic is needed for the restore state. The hardware input is the trigger to put 
the system into a Global Lock or Global Unlock state, but the operator must clear the state using 
the Situation Manager icons on the ribbon bar.
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1. To set the Global Reset Type, click in the Global Reset Type field in the grid and select the 
Latched or the Momentary option in the pull-down menu.

2.4.9 Ignore Old Events
Sets the amount of time before the system considers a past Global Lock/Unlock event as “old.” The 
intent of this option is to handle offline gateways/controllers that have global inputs that were 
triggered at some point in the past but have yet to be reported to the system. When they do report, it 
may be undesirable to initiate Global Lock/Unlock events based on hardware inputs triggered in the 
past, especially if these inputs were being used as momentary triggers. Global Lock/Unlock input 
reports that are deemed to be old are not processed. This applies to events that are from the inputs that 
are designated as either a Global Lock input or a Global Unlock input and does not affect operation 
from the UI, Global Linkage, or System Calendar.

NOTE: If an input is not processed because it is considered old, it is possible to have the input in one 
state and the system in another state. This condition should be handled by toggling the input while the 
controller is online to reset its state.

The time period for designating an event as old ranges from Never to between 1 minute and 24 hours. 
The default is Never.

• Never means the incoming input state is applied immediately, following the rules configured for 
the Situation Manager.

• A time-period selection (1, 2, 3, 4, 5, 10, 15, 30, 45 minutes – 1, 2, 4, 8, 12, and 24 hours) means 
the GMT time stamp for the incoming input state is checked against the system’s current GMT 
timestamp. The difference in minutes is compared to the Ignore Old Events setting. If the number 
of minutes is greater than or equal to this setting, the event is ignored and no Global Lock/Unlock 
processing occurs. If less than, then the incoming input state is applied immediately, following the 
rules configured for the Situation Manager.

1. To set a time period after which events are deemed “old,” click in the Ignore Old Events field in 
the grid and select the desired time period from the list in the pull-down menu.

2.4.10 Global Restore Trigger
Allows a Global Linkage action to trigger off of a Global Restore event; Global Linkage is not 
triggering the Restore event, but is triggered by the execution of the Restore event. This kind of 
trigger/action could turn on a relay, or send an e-mail or SMS message.

NOTE: This option can only be used with the optional Global Linkage feature.

1. To assign a Global Linkage trigger to a Global Restore event, click in the Global Restore Trigger 
field in the grid and select the desired Global Linkage trigger from the list in the pull-down menu.
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2.4.11 Global Unlock Trigger
Allows a Global Linkage action to trigger off of a Global Unlock event; Global Linkage is not 
triggering the Unlock event, but is triggered by the execution of the Unlock event. This kind of 
trigger/action could turn on a relay, or send an e-mail or SMS message.

NOTE: This option can only be used with the optional Global Linkage feature.

1. To assign a Global Linkage trigger to a Global Unlock event, click in the Global Unlock Trigger 
field in the grid and select the desired Global Linkage trigger from the list in the pull-down menu.

2.4.12 Global Lock Trigger
Allows a Global Linkage action to trigger off of a Global Lock event; Global Linkage is not 
triggering the Lock event, but is triggered by the execution of the Lock event. This kind of trigger/
action could turn on a relay, or send an e-mail or SMS message.

NOTE: This option can only be used with the optional Global Linkage feature.

1. To assign a Global Linkage trigger to a Global Lock event, click in the Global Lock Trigger field 
in the grid and select the desired Global Linkage trigger from the list in the pull-down menu.

2.5 Save Your Changes
You must save your changes or they will not be applied.

1. Click the Save Icon to save the option change.

2. A Save Changes confirmation window appears. Click Yes to confirm the option change.
3. Return to the Home tab. The Situation Manager icons appear on the ribbon bar.

4. The highlighted icon reflects the current state of the system.
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3.0 Hardware Configuration
Hardware configuration allows you to assign/unassign doors individually to the Global Lock and 
Global Unlock functions and assign Inputs as trigger points.

NOTE: Hardware configuration options become read-only if the system is in an active Global Lock 
or Global Unlock state. This prevents a configuration change from being made that may affect or 
confuse the current Global Lock/Unlock state. This read-only state does not apply to other properties 
or configuration options for other features within the program.

1. Click the Setup tab > Hardware Setup ribbon icon to perform hardware configuration.

3.1 Enabling Global Lock/Unlock in PXL Controllers
For each PXL controller using Global Lock/Unlock, you must first enable the Global Lock/Unlock 
option. For each PXL controller in the hardware tree:

1. Locate the Options > Use System Global Lock/Unlock pull-down menu.
2. Set this option to True for each controller participating in Global Lock/Unlock commands.

3.2 Doors
If the Situation Manager is enabled, two additional properties in the Doors grid are enabled. These 
two properties control whether or not each reader participates in Global Lock or Global Unlock 
commands. The default is to not ignore Global Lock or Global Unlock commands.

1. In the Hardware Setup tab, click the Doors tab.
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2. Select a Door to be assigned or unassigned to Global Lock or Global Unlock functions.
You may need to widen the Description column to ensure you are selecting the desired door.

3. Click/enable the Advanced View icon in the grid to view the Situation Manager Global Lock/
Unlock properties.

4. Scroll down the grid and locate the Situation Manager options.

5. Click in the Ignore Global Unlock field and select from the pull-down menu: 
Yes to ignore Global Unlock commands or No to respond to Global Unlock commands.

6. Click in the Ignore Global Lock field and select from the pull-down menu: 
Yes to ignore Global Lock commands or No to respond to Global Lock commands.

3.3 Input
If the Situation Manager is enabled, two additional properties in the Inputs grid are enabled. These 
two properties designate an input as either a Global Lock input or a Global Unlock input; an input 
cannot be both. The default is for inputs to not be configured as a Global Lock or Global Unlock 
input.

NOTE: You do not have to designate a hardware input for Global Lock or Global Unlock if you wish 
to use only the Situation Manager ribbon icons to activate/deactivate Global Lock and Global Unlock 
commands.
1. In the Hardware Setup tab, click the Inputs tab.
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2. Select an Input to be assigned or unassigned to trigger Global Lock or Global Unlock functions.
You may need to widen the Description column to ensure you are selecting the desired input.

3. Ensure Advanced View in the grid is enabled.
4. Scroll down the grid and locate the Situation Manager options.

5. Click in the Global Lock Input field and select from the pull-down menu: 
Yes to configure this input to trigger a Global Lock.

6. Click in the Global Unlock Input field and select from the pull-down menu: 
Yes to configure this input to trigger a Global Unlock.

NOTE: You may configure multiple inputs on multiple controllers on multiple gateways to be either 
Global Lock or Global Unlock inputs. You are not limited to a single input for either action.

3.4 Save Your Changes
You must save your changes or they will not be applied.

1. Click the Save Icon to save the option change.

2. A Save Changes confirmation window appears. Click Yes to confirm the option change.
3. The Situation Manager for the system is now fully configured.
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4.0 Typical Applications
The following sections provide typical application descriptions for Global Lock/Unlock. Unless 
otherwise noted, these applications apply to NXT, PXL, and MSC based hardware. All of these 
applications can use Global Linkage triggers to send SMS/E-mail. They can also perform hardware 
control via Global Linkage if the Global Linkage option is enabled on the license.

4.1 Software Driven ONLY
This application is the simplest form of Global Lock/Unlock as it is completely software driven and 
requires no input wiring. The only hardware configuration required is for doors to be assigned/
unassigned Global Lock/Unlock values accordingly. Any client/operator with the appropriate 
permission can execute a Global Lock or Global Unlock command. The following graphic shows the 
Situation Manager parameters to set to enable this mode:

Setting the Hardware Control option to Software Has Precedence enables the Situation Manager 
icons on the ribbon bar for active use. This means the operator can click the desired mode using the 
Situation Manager icons and the system will execute the change.

4.2 Hardware Initiated With Software Reset
This application is an extension of the Software Driven mode but with the controller also providing a 
momentary hardware input source for the Global Lock/Unlock state change. The input device should 
be a momentary push-button switch. Hardware configuration consists of the doors to be assigned/
unassigned Global Lock/Unlock values and defining the inputs that initiate a Global Lock/Unlock 
event. Multiple inputs may be configured for either function.

In this application a number of momentary push-button switches are located throughout a facility. A 
activation from any one of them will trigger the Global Lock/Unlock state according to its 
programming. But when the switch returns to its normal state, no change occurs; the system remains 
in the Global Lock/Unlock state. The Situation Manager icons will reflect the Global Lock/Unlock 
state. An operator with the appropriate permissions must change the state to Normal via the Situation 
Manager icon, hence the software reset distinction. The following graphic shows the Situation 
Manager parameters to set to enable this mode:
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By setting the Global Reset Type to Momentary the hardware input now can trigger the state change 
but cannot reset the system back to normal. This must be done through the System Manager icons. 
Since Hardware Control is set to Software Has Precedence it is still possible to initiate a Global Lock/
Unlock from the Situation Manager icons.

4.3 Hardware Driven ONLY
For this application the system Global Lock/Unlock state is completely controlled by latched input 
hardware. The Situation Manager icons only display status, they cannot initiate or clear a Global 
Lock/Unlock. The input hardware should be some kind of on/off toggle switch. Hardware 
configuration consists of the doors to be assigned/unassigned Global Lock/Unlock values and 
defining the inputs that control Global Lock/Unlock events. The following graphic shows the 
Situation Manager parameters to set to enable this mode:

Once configured, the system tracks multiple inputs over multiple controllers. If the system is in the 
Normal state, the first Global Lock input triggered will place the entire system into the Global Lock 
state. If another Global Lock input goes active, it is added to a list of active Global Lock inputs. When 
the first switch is returned to Normal, there is no change in the Global Lock state as the second switch 
is still active. It is only when all global lock inputs return to Normal that the system returns to the 
Normal state.

As shown in the graphic above, Global Unlock Has Precedence. So if the system is in the Global 
Lock state and one or more Global Unlock inputs are activated, the system immediately changes to 
the Global Unlock state. The same input logic applies here as with multiple Global Lock inputs. The 
system now waits until all of the Global Unlock inputs are normal before changing the system state. 
The system then checks to see if at least one Global Lock input is active. If one is active, the system 
will return to the Global Lock state. If none are active, the system then returns to Normal. If 
Precedence is set to Global Lock Has Precedence, then the logic above is reversed and a Global Lock 
can countermand an existing Global Unlock state.
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4.4 Hardware or Software Driven
This application allows either the Hardware or the Software to control a Global Lock/Unlock. This 
allows the software to override to the system without having to rely on all Global Lock/Unlock 
hardware inputs to be synchronized. The input hardware should be some kind of on/off toggle switch. 
Hardware configuration consists of the doors to be assigned/unassigned Global Lock/Unlock values 
and defining the inputs that control Global Lock/Unlock events. The following graphic shows the 
Situation Manager parameters to set to enable this mode:

All rules from the Hardware Driven ONLY section apply except that the Situation Manager icons can 
now initiate or clear a Global Lock/Unlock, overriding what the hardware initiated state may be. This 
will result in a mismatch between hardware and software. The hardware inputs must be changed to 
synchronize the software and hardware states. Keep in mind, the Situation Manager icons always 
correctly reflect current state.

NOTE: This mode can be useful for assisting in troubleshooting a system that may have hardware 
communication problems.

4.5 Advanced Applications Using Local Linkage
The MSC (Mercury Powered) firmware is capable of triggering on Global Lock/Unlock or Normal 
state changes using the optional Local Linkage feature. The full local linkage menu allows you to 
perform local linkage procedures such as the following:

• Change selected readers from a Global Lock mode (i.e., Lock, Lock Out, Lock Down) to a 
different mode (i.e., Unlocked, Card+PIN, a different Global Lock mode).

• Disable access rules for selected access groups while allowing other access groups to function 
normally.

• Toggle a control point to activate a siren, strobe light, or such device.
• Allow operator defined linkage triggers to use the same logic as in AutoUnlock triggers (i.e., 

prevent a trigger from occurring while in a Global Lock/Unlock state).

These applications are made possible by including the Global Lock and Global Unlock Trigger 
variables (used by the MSC based controller to indicate its current “Global” state) as selections in the 
local linkage trigger menu.

NOTE: These two trigger variables are not displayed in the local linkage procedure menus as the 
system cannot allow the controller itself to change Global Lock/Unlock states.
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4.5.1 Local Linkage Example – Trigger On Global Lock
The following trigger macro will execute whenever the Global Lock variable is changed by the 
system:

This trigger can execute a local linkage procedure that can accomplish a number of different tasks. It 
can be used to turn off certain schedules that will deny access to a certain group of cardholders (which 
will affect all cardholders assigned to that schedule). It can also be used to change the mode of 
selected readers to something different than the Global Lock type setting (configuring those readers to 
ignore the Global Lock/Unlock command). There are many more macro possibilities that can be 
performed from this trigger; essentially anything except turning off the trigger variables for Global 
Lock/Unlock.
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4.5.2 Local Linkage Example – Prevent Trigger On Global Lock/Unlock
To stop certain local linkage triggers from executing when Global Lock or Global Unlock is in effect, 
set the trigger variable logic as shown below:

NOTE: This example uses Boolean Arithmetic. Please be familiar with Boolean Arithmetic before 
attempting to program this type of macro.

Note the ! symbol in front of the Global Lock and Global Unlock trigger variables. This means that 
this trigger will only execute if both Global Lock and Global Unlock are False. The ! is a Boolean 
variable representing the NOT (or inverse) so we have NOT False AND NOT False which is the same 
as TRUE AND TRUE. So if either one is true then we have a NOT TRUE and therefore the trigger 
will not execute.

The Global Lock and Global Unlock trigger variables can also be used individually as part of a trigger 
macro to have the controller perform certain events (like a door forced open or held open) differently 
when either of these are in effect. In this case configure the trigger without the ! and define the rest of 
the trigger.
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5.0 Handling Offline or Network Outage States
The system is designed to have the ability to handle communications loss to controllers or network 
outage and recover from those when communications is restored. A system entering into or already in 
a Global Lock/Unlock state can be greatly affected by an offline controller or a network outage. The 
system is designed to handle recovery from these conditions, and to mitigate the effects the recovery 
may have on the system. The following conditions are currently handled:

• The Gateway service is not running when the system state is changed. The state change could be 
software based or could occur via an input from another Gateway that is online.

• The Gateway is online but a controller on that Gateway is offline.
• The Gateway service is running and was connected to Application Server but is offline when a 

state change occurs.
• The Client UI is not running when a state change occurs.
• The Client UI is running and was connected to Application Server but is offline when a state 

change occurs.
• A controller with a Global Lock or Global Unlock input and those inputs are Normal goes offline, 

and then a state change occurs.
• A controller with a Global Lock or Global Unlock input and those inputs are Active goes offline.
• A power outage or Application Server service stoppage.

Both the Client UI and the Gateway retrieves the current system state and Situation Manager rules on 
startup and on a reconnect to the Application Server. The Client UI will change its Situation Manager 
icons to match the current state. The Gateways will check each controller as it comes online (either at 
initial startup or a reconnect) for the controller’s current state (Normal, Global Lock, Global Unlock). 
If the controller’s state does not match the Gateway’s current state, the Gateway will update that 
controller to the correct state.

The Application Server updates the database when in Latched mode as the changes happen to Global 
Lock or Global Unlock inputs. This happens in real time as the events are sent to the Application 
Server. This table is only updated by the Application Server and is queried at Application Server 
startup. This ensures the current state of the Global Lock and Global Unlock inputs will still be valid 
following a planned or unplanned shutdown of the Application Server service.

NOTE: If the Situation Manager is configured to be Hardware Driven then the following could occur:

1. A controller that is offline has a number of events stored that involve Global Lock or Global 
Unlock. When that controller comes online, those events will be processed by the Application 
Server. If they are older than the time specified by the Situation Manager’s Ignore Older Events 
field, then nothing happens to the current state. If they are not older, they will be processed as 
normal events. This may or may not change the current Global Lock/Unlock state depending on if 
another input had already placed the system into a Global Lock/Unlock state and which state has 
precedence. If the system is in the Normal State when the controller comes back online and 
started uploading its transaction buffer, and those events are not considered “old,” the system state 
may change rapidly.
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2. A controller that has a Global Lock or Global Unlock input that is active is now offline. In this 
condition, the state will not restore to Normal until that controller comes back online and reports 
that the input is now normal. This is by design and is one of the reasons why the mixed-mode of 
hardware/software precedence is allowed.

6.0 Contact Keri Systems

End of document.

Keri USA Keri UK, Ireland, Europe

2305 Bering Drive
San Jose, CA 95131

Unit 17 
Park Farm Industrial Estate 

Ermine Street 
Buntingford 

Herts SG9 9AZ UK 

Telephone: (800) 260-5265
(408) 435-8400

Telephone: + 44 (0) 1763 273 243

Fax: (408) 577-1792 Fax:+ 44 (0) 1763 274 106

Web: www.kerisys.com Web:www.kerisystems.co.uk

E-mail: sales@kerisys.com
techsupport@kerisys.com

E-mail:sales@kerisystems.co.uk
tech-support@kerisystems.co.uk
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